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California Energy Commission
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Welcome and Opening Remarks



Adam Hart, Cache Creek Casino
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Yocha Dehe Wintun Nation 
Energy Initiatives 
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1. Vision

2. Colusa Indian Energy

3. Solar 

4. Sustainable Projects

5. Battery Energy Storage System         

(BESS)

6. Thermal Energy Storage 

A G E N D A



Our vision is to build a sustainable future for generations to 

come by implementing impactful green initiatives that 

propel our company forward. 

We are committed to developing sustainable energy 

solutions, prioritizing clean energy and continuously 

reducing our carbon footprint.

1



C O L U S A  I N D I A N  E N E R G Y  

2

• Colusa Indian Energy, in collaboration with Cache 

Creek Casino Resort, is developing an advanced 

microgrid to strengthen our community’s clean 

and reliable energy infrastructure. 

• This partnership integrates resilient, on-site power 

generation and intelligent energy management to 

enhance operational reliability, reduce emissions, 

and support long-term sustainability goals.

• Together, the project demonstrates a shared 

commitment to energy independence, 

environmental stewardship, and innovative tribal 

leadership in clean energy development.



S O L A R  A R R A Y  O V E R V I E W  
 • The existing solar array was originally installed in 2004 with a total 
system capacity of 264.5 KW.

Modernization 

• The new solar array is expected to increase total capacity to approximately 600 
KW, representing a significant output upgrade.

• A full system replacement is planned for, utilizing modern solar technology and 
updated inverters.

• The replacement system will be designed to fit within the same physical footprint 
and utilize existing infrastructure.

• This upgrade will improve overall energy efficiency, system reliability, and 
long-term return on investment while supporting sustainability and energy 
cost-reduction goals.



A E R I A L  P H O T O  /  S O L A R  A R R A Y



F U T U R E  S O L A R  I N S T A L L A T I O N  –  1 , 9 3 8 . 7 4  K W
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S U S T A I N A B L E  P R O J E C T S  

Microgrid 

• We are equipped to produce up to 12.5 MW of power. 

• The plant consists of five natural gas caterpillar  
generators. Each generator is capable of producing 
2.5 MW.

• We are currently engineering / designing a Battery 
Energy Storage System (BESS) for stabilization.

Waste Water Treatment Plant

• The facility is designed to treat up to 350,000 gallons 
per day using hollow fiber Membrane Bioreactors 
(MBR) technology.

• The treated water is reused for irrigation and toilet 
flushing.

4



T H E R M A L  E N E R G Y  
S T O R A G E  

• Thermal Energy Storage (TES) Tank – CCCR
Installed in June 2008 to reduce peak electrical demand and 
energy costs.

• Peak Load Reduction
Chilled water is produced during off-peak hours and utilized 
between 4–9 PM on summer days, lowering peak power 
usage.

• Prolong the Life of Equipment / Energy Cost Savings
Has reduced chiller wear, run time and maintenance costs. The 
system has dramatically reduced electrical costs. 

• Environmental Benefits
Reduced CO₂, NOₓ, and SO₂ emissions.

5



B A T T E R Y  E N E R G Y  S T O R A G E  S Y S T E M  ( B E S S )

• Engineering and design phase in 
progress.

• Reduces energy costs by using 
power more efficiently.

• Improves reliability and provides 
stabilization during power 
transfers. 

• Supports sustainability goals by 
maximizing renewable energy use 
and cutting emissions. 

6



T H A N K  Y O U  !  

Thank you ! 



Pilar Thomas
Moderator: Kelsey Freeman, CEC
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Energy and Economic 
Development in Indian Country



Energy and Economic 

Development in Indian Country

Summit on Tribal Energy Enterprise and Workforce 

Development

April 24, 2026

PILAR THOMAS, ESQ.

ADJUNCT PROFESSOR

UNIVERSITY OF ARIZONA SCHOOL OF LAW
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Why Do Tribes Develop Their Energy 

Resources?

 Jobs

 Revenues

 Experience

 Cost savings / cost stabilization

 Energy reliability

 Self reliance

 Environmental sustainability

 Climate change mitigation, adaptation, resiliency

17



Potential Tribal Roles in Energy 

Development 18

TRIBE

•Project Developer/

Operator

• Lender

• Investor

• Resource Owner(Royalties)

• Offtaker (power purchaser/user)

    



Scale of Development Options

 Commercial/Utility Scale

 Resource as a commodity

 Generate revenue and jobs

 Economic development support (direct access to clean 

power, competitive advantages)

 Community/facility scale

 Resource as a public good

 Cost savings, stabilization

 Community development support (affordable housing, 

government facilities)

19



Legal / Regulatory Considerations

 Federal Jurisdiction 

 Control over Indian lands (trust responsibility and Non-Intercourse 
Act)

 Federal energy and environmental laws and regulations

 Federal energy policies – administration and legislation

 State Jurisdiction – generally doesn’t apply on Indian lands; 
control over non-Indians, energy companies 

 Regulated non-tribal utilities 

 Non-tribal developers/owners

 "off-reservation" portion of the project

 Tribal Jurisdiction – control over own development, use

 Tribal laws, policies, custom

 Self-determination development authorities – HEARTH Act, TERAs, 
TEDOs, TAS

 Conflicting authorities – state vs. tribal regulation of non-Indian 
entities (energy, taxation, environmental)

20



Key Federal Indian Energy 

Regulatory Laws

 Oil, Gas, Geothermal, Mining leases and 

agreements

 Land Use Laws (leasing, easements, 

encumbrances)

 Tribal Energy Laws (TERAs)

 Environmental Laws (NEPA, NHPA, ESA, CAA, 

CWA)

 Energy Policies (FPA, PURPA, IRC)

21



Current Federal Energy Policies
 Trump Administration:

 "Unleashing American Energy" - emphasis on fossil fuels, 
nuclear, hydroelectric, geothermal; energy dominance

 Termination of clean energy related grants (EPA, DOE)

 DOI restrictions on solar and wind development on federal 

and tribal lands

 Revised DOI NEPA/NHPA for certain energy and mining 

projects

 Congress:

 Repeal of IRA and other clean energy and infrastructure 
funding

 Restriction of solar and wind tax credits

Serious federal headwinds!!!!

22



State/Local Jurisdiction and 

Energy Policies

 Not generally applicable on Indian lands

 Utility regulatory policies: tariffs, incentive programs, 
siting requirements, interconnection requirements, 
ratepayer programs (i.e., rooftop solar, community 
solar)

 Environmental protection: environmental impacts, 
wildlife, waters, health and safety

 Taxation policies: property, sales, excise taxes, taxes 
on tribal lands

 Zoning and permitting: local government

 CA – three regulatory entities (CPUC, CEC, CAISO)

23



Tribal Laws and Policies

 Legal Infrastructure – scope dependent on federal 
law and common law

 Leasing

 Building Codes

 Environmental Review and Protection

 Labor and Employment

 Taxation

 Utility Codes & Regulations

 Policies and Planning

 Environmental, cultural resource protections

 Community involvement

 Self-Perform

 Utility ownership

 Project ownership

24



CA Tribal Examples

 Pechanga Western – tribal owned and operated 

electric utility

 Blue Lake Rancheria – first tribal micro-grid, 

capable of islanding

 GRID Alternatives – rooftop solar on tribal housing 

for over 30 California tribes

 Tule River – EDC developed and deployed solar + 

storage and EV charging stations on C-Store 

properties

 Twenty-Nine Palms – developing natural gas 

based micro-grid for enterprise energy reliability

25



Summary of Key Opportunities for 

Tribal Sovereign Energy 

Development

 Ability to use own energy and other natural resources on 

own terms – for public good or for commercial use

 Control land use, taxation, labor, environmental review

 Regulate energy service providers and producers

 Partnerships with developers, off-takers, state agencies

 Avoid multiple layers of approvals for major projects 

(whether energy, industrial, data center, commercial)

 Foundational for community and economic development 

goals:  jobs, revenue, lower cost energy

26



State Agency Opportunities
 Great momentum from Gov. Brown to Gov. 

Newsom:

 Tribal consultation policies

 Tribal government relations personnel

 Critical financial support

 Electoral risk – new incoming administration

 Freeze in place?

 Race to advance?

 Comity

 Tribal carve-outs – programs, regulations, funding

 Stakeholder relations – especially energy and 
related counter-parties

 Disclaim jurisdiction – taxes, fees, regulations (just 
because you can doesn’t mean you should)

27



Morning Break
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Josh Simmons, Tribal Energy Climate Collaborative
Tracy Stanhoff, American Indian Chamber of 

     Commerce of CA
Moderator: Chair David Hochschild, CEC

30

Building Partnerships for a 
Clean Energy Economy



Building Partnerships for a 
Clean Energy Economy

California Energy Commission Statewide Summit on 
Tribal Energy Enterprise and Workforce Development

April 24, 2026



Overview of Our Tribal Work in the Energy Space

• Encountered Lack of Infrastructure

• Advocacy with Our Chamber Partners

• Holding Tribal Infrastructure Summits

• Facilitating Meetings with Government Agencies 
on the Needs, Tribal Leader Voices Heard

• Connecting Utility Tribal Liaisons 

• Bottomline – One Needs Infrastructure for 
Economic Self Sufficiency Aligning With Our 
Mission



Josh Simmons
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Tribal Energy Climate 
Collaborative





TECC: Tribal Energy & Climate Collaborative

Policy & Regulatory Advocacy
Education, training, and engagement 

in climate and energy policies, 
programs, and regulatory proceedings

Capacity Building & Technical 
Assistance (TA)

Energy, climate, and economic 
development TA, grant writing 

assistance, training, capacity building 

Economic and Workforce Development
Planning, due diligence, and support to 
accelerate Tribally-led innovative clean 
energy and climate technologies and 

ventures

Identify and advance climate, energy, and related economic and 
workforce development goals of SCTCA Tribes

TECC Initiatives
• Regional Climate Collaborative (SGC)
• SoCal Regional Energy Network Tribal Engagement (LA County)
• San Diego Regional Energy Network Tribal Engagement (San Diego Community Power)
• SoCal EBD Program Tribal Engagement (LA County)
• Access Clean California Tribal Capacity Building (Grid Alternatives/CARB)
• TECC Innovation Ecosystem (GoBiz CJF RII)
• CPUC Regulatory Training and Advocacy Program (CPUC)
• SoCal Tribal EV Infrastructure, Planning, and Workforce Development (CEC)
• California Tribal Gap Analysis Project



TECC: Tribal Energy & Climate Collaborative

Policy & Regulatory Advocacy
Capacity Building & Technical 

Assistance (TA)
Economic and Workforce Development

Identify and advance climate, energy, and related economic and 
workforce development goals of SCTCA Tribes

• 300+ hours advocating on CPUC 
matters, including: SGIP, Tribal OIR, 
ROW, Energization, IComp, Labor

• Convened Tribes, Agencies, IOUs 
on interconnection/energization

• Decision preserving $6M for 20+ 
Tribal energy storage projects

• 10 Advancing Tribes' Interests at the 
CPUC Trainings w/ 130+ registrants

• 600+ hours of stipend-eligible 
activities by 24 TECC Tribes

• ID’d 50+ Priority Needs/Projects 
• 40+ Technical Assistance Requests
• Funding Assistance → ~$24M
• 7 TECC-X meetings w/ ~80 ppl avg. 

And 390+ registrants
• $1.6M REN and EBD contracts
• $3M CEC EV Infrastructure grant

• Scanned 30+ startups/technologies
• Eight (8) due diligence studies
• Persevered through NSF Engines grant 

termination (loss of $700K+)
• Designed, planned, secured $2M GoBiz 

RII grant for innovation ecosystem to 
advance Tribally-led ventures

• EV charger training-workforce grant



Josh Simmons, Tribal Energy Climate Collaborative
Tracy Stanhoff, American Indian Chamber of 

     Commerce of CA
Moderator: Chair David Hochschild, CEC
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Building Partnerships for a 
Clean Energy Economy



Ken Ahmann, Colusa Indian Energy
Nicole Reiter, Indian Energy

Moderator: Commissioner Matt Baker, CPUC
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Clean Energy as a Tool for 
Economic Development



Lunch Break
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TeMashio Anderson , Tribal Energy Alternatives
Dylan Aubrey, Tribal Workforce Trade Assn.

Elizabeth Perez, NESCO
Moderator: Commissioner Noemí Gallardo, CEC
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Building an Effective Workforce 
Development Program

https://www.google.com/search?q=S%C3%AD&rlz=1C1GCEA_enUS1168US1168&oq=accented+i+&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIHCAEQABiABDIHCAIQABiABDIHCAMQABiABDIHCAQQABiABDIHCAUQABiABDIHCAYQABiABDIHCAcQABiABDIHCAgQABiABDIICAkQABgWGB7SAQgyNDI0ajBqN6gCALACAA&sourceid=chrome&ie=UTF-8&ved=2ahUKEwjPx8KslYCUAxUbITQIHe92NZYQgK4QegYIAQgAEA0


TeMashio Anderson
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Tribal Energy Alternatives



Elizabeth Perez
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NESCO



NESCO
LIFETIME OF SERVICE



Tribal Workforce Trade Association (TWTA)

Tribal Workforce 

Trade Association 

(TWTA)

California Energy Commission



High-Level: What TWTA Does

High-Level: What TWTA Does

● TWTA is:
○ Policy advisors
○ Strategic Partners with Tribal, State, Federal and Local 

Organizations, Unions, and Private Developers
○ Native American Contractors and Small Business Development
○ A Native-led workforce coordination system
○ A regional Historic Indigenous Peoples apprenticeship program
○ A compliance and reporting hub (through iPartnerships)
○ Surety Bond Guarantee Program (Performance, Payment, Bid)
○ A sovereign economic development tool

We do not replace TERO

We unify and scale TERO capacity.



THIRD-PARTY ADMINISTRATION

THIRD-PARTY ADMINISTRATION

Who We Are

A strategy and compliance consulting firm specializing in workforce systems, project agreements 

management, and Registered Apprenticeship.

What We Do

• Design sustainable program infrastructure, policies, and quality assurance systems.

• Conduct compliance reviews, equity assessments, and workforce strategy development.

• Provide training, tools, and implementation support for long-term program success.



The TEK Certification Program establishes a formal standard to integrate Traditional Ecological 
Knowledge (TEK) into the built environment through alignment with the Construction 
Specifications Institute (CSI) MasterFormat.

This positions Indigenous knowledge at the design phase, not just implementation.

• Working with project owners 
during 10-year fiscal and capital 
planning cycles
• Ensuring place-based 
Indigenous knowledge is 
incorporated into project 
specifications

• Embedding TEK requirements
directly into procurement and 
design standards

Through this framework, This creates a pathway to: 

we are:

• Influence how projects are 
designed before they are 
funded

• Require TEK-aligned 
practices within project 
delivery
• Secure long-term roles for

Tribal practitioners, 
contractors, and land 
stewards

By integrating TEK into 
CSI standards, we:

• Move from consultation to

codified implementation

• Align funding, design, and

workforce under Indigenous

frameworks
• Ensure projects reflect the

ecological and cultural 

realities of the land they 

impact

TEK Certification  CSI Integration: Embedding Indigenous Knowledge into Project Delivery

TEK Certification & CSI Integration: Embedding Indigenous Knowledge into
Project Delivery



CENTERING THE WORKER

ECONOMIC IMPACT

ECONOMIC IMPACT

Worker Wages

Total Construction Budget $ 2 80 M i I I i o n

Construction SpendingDire $ 2 01 M i I I i o n

ctEconomic Output $ 226 M i l l i o n

lndirectEconomic Output $ 3 95 M i I I i o n

$ 8 3 Mi II ion
TradeWorkJobs 1030

Wage Rangeperseason

Median Annual Wages

$ 4 2 , 0 0 0 - $ 1 0 8 , 0 0 0

HumboldtCounty $ 3 1 , 0 0 0
DelNorte County $ 3 6 , 0 0 0

- �



CENTERING THE WORKER

Types of Economic Impact

Types of Economic Impact

Direct Impact: The immediate economic activity generated by 

the project. Direct impacts include the initial spending, 

employment wages, and economic output directly attributable

to a project.

Indirect Impact: Indirect impacts occur when businesses that 

receive direct spending make additional purchases from their 

suppliers, creating a supply chain reaction.

Induced Impact: Induced impacts result from household 

spending of wages earned through direct and indirect 

employment, creating additional demand and employment



Vendor Lists as a Strategic Lever for Tribal Economic Development

Vendor Lists as a Strategic Lever for Tribal Economic Development

A complete and active 
vendor list allows us to:

• Build a coordinated pipeline for Native 
business development across trades
• Align tribal contractors with upcoming 
project procurement opportunities
• Identify where capacity exists — and 
where it needs to be strengthened

This creates a direct pathway to:

• Increase job creation by matching projects to Native-
owned firms
• Develop targeted apprenticeship pipelines tied to real
contract demand
• Close skill gaps by strategically leveraging union
partnerships when neededWith a clear understanding of capabilities across regions, we can:

• Rapidly align opportunities as they arise
• Coordinate across tribes instead of competing in silos
• Position Native contractors and workforce at the front of project delivery



MWIS PROGRAM OVERVIEW

MWIS PROGRAM OVERVIEW Merriwether & Williams Insurance Services · A HUB International Company

THE FOUR PILLARS

01 Capacity assessment, customized workplans& referrals to
program partners

ASSESSMENT & TECHNICAL ASSISTANCE

02

BONDING, FINANCING & PROJECT ASSISTANCE

Bonding capacity,collateral support, CDFI financing & field
support

03

EDUCATION, TRAINING & CONTRACT SUPPORT

Group classes, expert-led sessions & contract-specific support

04

PRIME CONTRACTOR PARTNERSHIPS

Strategic alliances, matchmaking, subcontracting &
prequalification

29 years · 4,000+ contractors

$1.12B bid bonds· $383M contractsawarded

$27.4M saved · $6.2M loansfunded

SURETY BOND GUARANTEE PROGRAM

THE CHALLENGE

Small contractors face significant barriers establishing bond lines, limiting their ability to bid on public

contracts. Sureties require explicit sovereign immunity w aivers before w riting bonds on Tribal projects

— a step many Tribes are reluctant to take.

THE SOLUTION

MWIS provides collateral through CDFI partnership, enabling contractors to secure or increase

bonding capacity — boosting bid participation and delivering cost savings to public agencies.

KEY ELEMENTS

• Tribal Sponsored Contractor Financial Guarantee Pool

• Irrevocable Letter of Credit issued by Surety

• Third Party Funds Administration

• CPA Financial Subsidies

• Transaction administration & contract monitoring by MWIS

• Field support through project completion — ensures collateral is returned

60+
Nativ e CDFIs

Serv ing Tribal Communities

$1B+
CDFI Capital

Deploy ed Annually

0
Programs Bridging

CDFI Lending & Bonding*

*The gap MWIS fills



Funding Structure Slide

Funding Structure Slide

Proposed structure:

1. Regional TERO contribution pool
2. Direct tribal government contributions
3. Workforce Innovation Act
4. Grants (early phase only)
5. Workforce dues (long term model)

Tribal contributions 
convert into:

● Priority coordination access
● Early workforce mapping support
● Participation in regional planning
● Access to compliance infrastructure

● Participation in regional advisory 

discussions

● Improved regional labor capacity



What we are Asking

What we are Asking

We are asking for:

1. Vendor & contractor lists

2. Owner requirements for priority local hire in ancestral territories for 

Native American workers and contractors

3. Owner requirments for TEK included in the master standard on 

projects.

4. Owner requirements meaningful participation for Native American's 

in the design faze.

5. Owner requirments for Native American Land stewardship to be 

written in the budget on lands the CECoperates in ancestral 

territories of Native American Communities.



TeMashio Anderson , Tribal Energy Alternatives
Dylan Aubrey, Tribal Workforce Trade Assn.

Elizabeth Perez, NESCO
Moderator: Commissioner Noemí Gallardo, CEC
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Building an Effective Workforce 
Development Program



Afternoon Break
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Jason Carrisoza & Max Spivak, Morongo Band of Mission Indians
Pi-Ta Pitt, Pechanga Western Electric

Kate Ellis, San Manuel Utility Authority
Moderator: Commissioner Darcie Houck, CPUC
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Tribal Utility Authorities and 
Energy Infrastructure Ownership



California Energy Commission 

Summit on Tribal Energy 
Enterprise and Workforce 

Development

Jason Carrizosa (Morongo Band of 
Mission Indians) – Chief Administrative 
Officer, MBMI

Max Spivak – In-House Counsel, MBMI

Yocha Dehe Wintun Nation, Cache Creek Casino Resort

April 24, 2026

©2026, Morongo Band of Mission Indians



‘Isill Héqwas Wáxish (“A Dried Coyote’s Tail”)
KATHERINE SIVA SAUVEL & ERIC ELLIOTT, ‘ISILL HÉQWAS WÁXISH: A DRIED COYOTE’S 
TAIL, 304. “Electricity at Málki’i’” 375–378 (Malki Museum Press 2004). 



Morongo Tribal Utility Authority Ordinance



Morongo Ordinance Regulating Utility 
Transmission Rights-of-Way









'Achama/'Enaac mih’

Jason Carrizosa 

jcarrizosa@morongo-nsn.gov, (951) 330-1391

Max Spivak 

mspivak@morongo-nsn.gov; (909) 677-7071



Pi-Ta Pitt
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Pechanga Western Electric



 How-to Edit the Footer Text in PowerPoint

(ex: “PRIVATE”):

1. Click the Insert tab.

2. Select Header and Footer from the menu.

3. In the pop-up window, check the box for Footer if it 

isn’t already enabled.

4. Edit the text field.

5. Click Apply to All for all slides.

Kate Ellis, General Manager

April 24, 2026

San Manuel Utility Authority

PRIVATE



How to Change the Number of Columns in a 

Text Box in PowerPoint:

Default text boxes are set to two columns, so longer text 

will automatically wrap into the next column. If you need 

to change the number of columns, follow these steps:

1. Select the text box you want to modify.

2. Go to the Home tab and click Columns in the 

Paragraph group.

3. Choose the number of columns from the dropdown. 

(One, Two, Three).

4. Click More Columns to adjust the number and 

spacing (the Space between columns is .25”).

5. Click Ok.

The columns will resize when you drag the text box 

edges.

How to Change a Slide Layout in 

PowerPoint:

1. Select the slide you want to change.

2. Go to the Home tab and click Layout in the Slides 

group.

3. Choose a new layout from the available options.

4. Adjust the content on the slide as needed to fit the 

new layout.

This will let you easily switch between different section 

layouts or between content slides for info-only, guidance, 

or decision.

Sovereignty

Reliability

Growth

Resiliency

Tribal Utility Authority Goals
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How to Change the Number of Columns in a 

Text Box in PowerPoint:

Default text boxes are set to two columns, so longer text 

will automatically wrap into the next column. If you need 

to change the number of columns, follow these steps:

1. Select the text box you want to modify.

2. Go to the Home tab and click Columns in the 

Paragraph group.

3. Choose the number of columns from the dropdown. 

(One, Two, Three).
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5. Click Ok.

The columns will resize when you drag the text box 

edges.

How to Change a Slide Layout in 

PowerPoint:

1. Select the slide you want to change.

2. Go to the Home tab and click Layout in the Slides 

group.

3. Choose a new layout from the available options.

4. Adjust the content on the slide as needed to fit the 

new layout.

This will let you easily switch between different section 

layouts or between content slides for info-only, guidance, 

or decision.

The Spectrum of Energy Supply & Delivery

Full IOU 

Customer
Independence

Wholesale 

Market 

Participant

Hybrid

IOU TUA and Others3rd Parties TUA
Energy 

Supplier

Delivery

Service
IOU N/AIOU TUA, IOU, others?
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How to Change a Slide Layout in 

PowerPoint:

1. Select the slide you want to change.

2. Go to the Home tab and click Layout in the Slides 

group.

3. Choose a new layout from the available options.

4. Adjust the content on the slide as needed to fit the 

new layout.

This will let you easily switch between different section 

layouts or between content slides for info-only, guidance, 

or decision.

SMUA Infrastructure Projects



How to Change the Number of Columns in a 

Text Box in PowerPoint:

Default text boxes are set to two columns, so longer text 

will automatically wrap into the next column. If you need 

to change the number of columns, follow these steps:

1. Select the text box you want to modify.

2. Go to the Home tab and click Columns in the 

Paragraph group.

3. Choose the number of columns from the dropdown. 

(One, Two, Three).

4. Click More Columns to adjust the number and 

spacing (the Space between columns is .25”).

5. Click Ok.

The columns will resize when you drag the text box 

edges.

How to Change a Slide Layout in 

PowerPoint:

1. Select the slide you want to change.

2. Go to the Home tab and click Layout in the Slides 

group.

3. Choose a new layout from the available options.

4. Adjust the content on the slide as needed to fit the 

new layout.

This will let you easily switch between different section 

layouts or between content slides for info-only, guidance, 

or decision.
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Future: Additional Utilities



Hakup a’ ai
Thank you



Jason Carrisoza & Max Spivak, Morongo Band of Mission Indians
Pi-Ta Pitt, Pechanga Western Electric

Kate Ellis, San Manuel Utility Authority
Moderator: Commissioner Darcie Houck, CPUC
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Tribal Utility Authorities and 
Energy Infrastructure Ownership



Jim Landrith, California Energy Commission
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TERAS Video
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CEC Video



Chairman Joe James, Yurok Tribe
Raymond McQuillen, Yurok Tribe

Matthew Marshall, Blue Lake Rancheria
Tyson Dempewolf, Hoopa Valley Public Utilities District

Moderator: Pete Alstone, Schatz Energy Research Center
76

Case Study: TERAS Project
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